ADAPT PT7
TUTORIAL FOR A NON-PRISMATIC SLAB

1. NON-PRISMATIC (SEGMENTAL) COLUMN-SUPPORTED SLAB

The objective of this tutorial is to demonstrate the step-by-step procedure of ADAPT-PT to model, analyze and design a three-span, non-prismatic two-way slab. Nonprismatic data entry must be used, when with the exception of drop caps and drop panels, the cross-sectional geometry of a member changes within the same span. This includes steps above or below the member, and changes in the tributary of slab. If the change in geometry within all the spans of a given structure is limited to that of drop cap and drop panel, conventional data input can be used and is more convenient for data entry. But, if in any of the spans, there is a different type of geometry change, the data input for the entire structure should use the “nonprismatic” option. This tutorial illustrates the features of data generation for non-prismatic members and walks you through the execution of data.

The procedure outlined in this tutorial is equally valid for non-prismatic beams.

The geometry, material, loading and other criteria of the structure are given in the following.
Views of the geometry is illustrated in Fig. 1-1.

(i) Material Properties

- Concrete:
  - Compressive strength, $f'_c = 4000$ psi (27.58 MPa)
  - Weight = 150 pcf (2403 kg/m$^3$)
  - Modulus of Elasticity = 3604 ksi (24849 MPa)
  - Age of Concrete at stressing = 3 days
  - Compressive strength at stressing, $f'_{ci} = 3000$ psi (20.68 MPa)

- Prestressing:
  - Low Relaxation, Unbonded System
    - Strand Diameter = ½ in (13 mm)
    - Strand Area = 0.153 in$^2$ (99 mm$^2$)
    - Modulus of Elasticity = 28000 ksi (193054 MPa)
    - Ultimate strength of strand, $f_{pu} = 270$ ksi (1862 MPa)
    - Minimum strand cover
      - From top fiber = 0.75 in all spans (19.05 mm)
      - From bottom fiber

---

1 Copyright ADAPT Corporation 2005
Technical Note

Interior spans = 0.75 in \((19.05 \text{ mm})\)
Exterior spans = 1.5 in \((38.1 \text{ mm})\)

Nonprestressed Reinforcement:
Yield stress \(f_y\) = 60 ksi \((413.69 \text{ MPa})\)
Modulus of Elasticity = 29000 ksi \((199,949 \text{ MPa})\)
Minimum Rebar Cover = 1in Top and Bottom \((25.4 \text{ mm})\)

(ii) Loading:
Dead load = self weight + 20 psf
Live load = 40 psf \((1.92 \text{ kN/m}^2)\)
Since the third span of the structure is non-prismatic, i.e., the tributary width of the section changes within the span, the input of the entire structure shall be based on the “nonprismatic” option.

1.1 Generate The Structural Model

In the ADAPT-PT screen, click the Options menu and set the Default code as ACI 02; UBC 97; IBC 2003 and the Default units as American.

A. Edit the project information

i. General Settings (Fig.1.1-1)

Open the new project by clicking either New on the file menu or the New Project on the toolbar. This automatically opens the General Settings input screen as in Fig. 1.1-1. You can enter the “General Title” and the “Specific Title” of the project. For the purpose of this tutorial, enter the General title as Three-Span Non-prismatic Two-Way Slab. This will appear at the top of the first page of the output. Enter the Specific title as Example 4. This will appear at the top of each subsequent page of the output.

Next, select the Structural System as Two-Way slab. Then you will be given an option to include drop caps, transverse beams and/or drop panels. This option depends on the Geometry Input.

Next, select the Geometry Input as Segmental, since the tributary width of the third span changes along the span. Click Help on the bottom line if you want to know about Conventional and Segmental Geometry input. Note that when you select the “Geometry Input” as “Segmental”, the option to include the drops and transverse beams is not available. Therefore, drop cap, drop panel and transverse beam in this tutorial are generating as a non-prismatic section.

Click Next at the bottom right of this screen, to open the Design Settings input screen.

![General Settings Screen](image)

FIGURE 1.1-1
ii. Design Settings (Fig.1.1-2)

This screen is used to select various calculation and design settings. First, select the *Execution Mode* as **Interactive**. In this mode, you have the opportunity to optimize the design by adjusting the tendon forces and tendon drapes for each span in the “Recycle” window. This will be explained later in this section.

Next, select **Yes** to *Reduce Moments to Face-of-Support* option. It indicates that the calculated centerline moments at each support are adjusted to the face-of-support. In addition to the centerline moments, ADAPT-PT prints out the moments reduced to face-of-support.

For a two-way slab system, you have an option of modeling the structure using the *Equivalent Frame* method. If it is not used, there is an option to *Increase Moment of Inertia Over Support*. This option will cause the program to use a larger moment of inertia over the supports than given by the cross-sectional geometry of the beam. This, in turn, affects the relative distribution of the moments and may affect the amount of post-tensioning required. Select **No** for both *Equivalent Frame Modeling* and *Increase Moment of Inertia Over Support*.

![FIGURE 1.1-2](image)

Click **Next** at the bottom right of the *Design Settings* screen, to open the *Span Geometry* input screen.

B. Edit the geometry of the structure

i. **Enter Span Geometry (Fig.1.1-5)**

This screen is used to enter the cross-sectional geometry of the slab.

Set the *Number of Spans* to **3** either by clicking the **up arrow** or using **CTRL +**. Then click on the checkbox next to “R-Cant” in the *Label* column to include the right cantilever.

Next, enter the dimensions. All dimensions are defined in the legend at the top of the screen and/or illustrated in the appropriate section figure. The section type for any span can be changed by clicking on the **button** in the section (Sec) column.
Since the structure is non-prismatic, you have to enter the data for all the segments in each span. Fig. 1.1-3 and Fig.1.1-4 are the 3-D and top perspective views of the model showing the subdivision of the system based on change in its cross-sectional geometry. The structure includes 8" (203 mm) wall at the first support, 18" (457 mm) diameter circular column with drop cap and drop panel at the second support, 16" (406 mm) square column with a longitudinal beam at the third support, 24" (610 mm) square column with a transverse beam at the fourth support and 5’ (1.52 m) cantilever beyond the last span. The cross-section changes at the face of the drop cap and drop panel, and at the face of the transverse beam. Also the tributary width changes in the third span. You have to enter the data for each segment individually.

In the Span Geometry input screen (Fig. 1.1-5) enter the cross-sectional geometry of each span at its mid-length (midspan, Sec, L, b, h etc), as if the entire span were prismatic. Input data for the remainder of the segments of each span will be entered later in a second input screen. For the first span, select the Sec as rectangular, edit L as 20 ft (6.10 m), b as 192 inches (4877 mm) and h as 10 inches (254 mm). Repeat this procedure for rest of the spans as shown in Fig. 1.1-5.

To enter the data for all the segments in each span, change PR (Prismatic) column to NP (Non-prismatic) from the drop down list for all the spans. This activates the More… button in the Segments (Seg) column (Fig.1.1-5).
Clicking on the More...button opens the Geometry-Span (More) window for that span. This is where you enter the cross-sectional geometry of the remainder of the segments of each span.

Click the More...button in Span1 to enter the segmental data for that span (fig.1.1-7). Figure.1.1-6 is the perspective view of the first span, which shows the locations where cross-sections change within that span. There are three segments in the first span; centerline of the wall to the face of drop panel, face of the drop panel to the face of the drop cap and from the face of the drop cap to the centerline of the circular column. So, set the Number of Segments as 3. Up to seven segments may be entered per span.

The parameters are input in the same manner as the midspan span geometry, except for the XL column, which is used to specify the distance from the left support centerline to the start of each segment. The length of each segment is calculated automatically based on the distance to the start of the next segment.
Note 1:
The XL column of the {more}... input screen will differ according to the selection in design settings input screen. The following flow chart summarizes the procedure.

If you select either Equivalent Frame or Increase Moment of Inertia in Design Settings screen, the more... input screen for the first span would be as shown in the following figure. In this case, the program automatically generates additional segments over each support using the geometry entered for the first and last segments. If these segments are generated before the support dimensions are entered, their XL values will be initialized with values of zero and the span length, respectively. These values will be updated when the support dimensions are entered.
Non-Prismatic

Beam
One-Way Slab

Increase Moment of Inertia Over Support

Program automatically generates additional segments over each support using the geometry entered. Therefore user cannot input XL for the first 2 segments and the last segment.

Do not Increase Moment of Inertia Over Support

Equivalent Frame Modeling

Non Equivalent Frame Modeling

Two-Way Slab

User can input the XL for the segment 2, i.e., from the left support centerline to the start of the next segment.

Equivalent Frame Modeling

Program automatically generates additional segments over each support using the geometry entered. Therefore user cannot input XL for the first 2 segments and the last segment.

Increase Moment of Inertia Over Support

Do not Increase Moment of Inertia Over Support

User can input the XL for the segment 2, i.e., from the left support centerline to the start of the next segment.

Non-Prismatic

Program automatically generates additional segments over each support using the geometry entered. Therefore user cannot input XL for the first 2 segments and the last segment.

FIGURE NOTE 1 -2
The first and last segments are always reserved for the portion of the slab (or beam) that falls over the support. These are calculated automatically by the program. You start by entering the geometry of the second segment. The start of the first segment is always zero. Enter \( XL \) for Segment 2 as 15 ft (4.57 m) (distance from the left support centerline to the face of the drop panel) and Segment 3 as 17.5 ft (5.33 m) (distance from the left support centerline to the face of the drop cap). Note that you cannot modify the \( XL \) column for the first segment. It is always zero.

**FIGURE 1.1-7**

Select the *section* for segment 1(0-15 ft) as rectangular with \( b \) equal to 192 inches (4879 mm) (tributary width) and \( h \) equal to 10 inches (254 mm).

For segment 2 (15 – 17.50 ft, face of drop panel to the face of drop cap) select *section* as T and enter 120 inches (3048 mm) (width of the drop panel) for \( b \), 22 inches (559 mm) (depth of the drop panel + thickness of the slab) for \( h \), 192 inches (4877 mm) (tributary width) for \( bf \), 10 inches (254 mm) (thickness of the slab) for \( hf \).

For segment 3 (spanning 17.50-20 ft, i.e., from the face of the drop cap to the centerline of the second support), select *section* as Ext T/L section and enter 60 inches (1524 mm) (width of the drop cap) for \( b \), 36 inches (914 mm) (depth of the drop cap + depth of the drop panel + thickness of the slab) for \( h \), 192 inches (4877 mm) (tributary width) for \( bf \), 10 inches (254 mm) (thickness of the slab) for \( hf \), 120 inches (3048 mm) (width of the drop panel) for \( bm \) and 22 inches (559 mm) (depth of the drop panel + thickness of the slab) for \( hm \).

Repeat the same procedure for span 2, span 3 and the right cantilever.

Span 2 also has three segments as in Span 1(Fig. 1.1-8).
Enter the data for each segment as in Fig. 1.1-9.

For span 3, there is a cutout in the slab from 5 to 10 ft (1.52-3.05 m), and a transverse beam at the right support. So there are 4 segments, 0-5 ft (0 -1.52 m)-centerline of the column to the beginning of the cutout, 5-10 ft (1.52 -3.05 m); cutout portion, 10-17 ft (3.05 – 5.18 m); end of the cutout to the face of the transverse beam and 17-18ft (5.18 – 5.49 m); transverse beam portion as in Fig. 1.1-10. Figure 1.1-10 also includes the top view of the right cantilever.
Enter the data for each segment of the third span as shown in the input screen below. (Fig. 1.1-11)

The right cantilever has two segments; centerline of the column to the face of the transverse beam, 0.1 ft (0 – 0.30 m), and the face of the transverse beam to the end of the span, 1.5 ft (0.30 – 1.52 m), as shown in Fig. 1.1-10. Enter the data for the segments as shown in Fig. 1.1-12.
Next enter the reference height. The reference height \((Rh)\) identifies the position of a reference line that is used to specify the location of the tendon. Typically, the reference line is selected to be the soffit of the member. Hence for this tutorial, select slab depth. Click with the \(Rh\) definition in the legend to know more about this.

Type the reference height, \(Rh\), as 10 inches (254 mm) for all the segments of all spans.

The Left and Right Multiplier columns (<\(-M\) and \(M>-)) are used to specify the tributary width to indicate how much of the tributary width falls on either side of the frame line. Enter 0.5 for both the left and right multiplier for all the segments of all spans, except for the second segment of span 3. There is a 3 ft (0.91 m) cutout, so the tributary width on either side of the frame line is different. Enter 0.62 for the left multiplier and 0.38 for the right multiplier as shown in Fig. 1.1-5. Note that the sum of left and right multipliers add up to be 1.

You can use the "Typical" row (top row) if several spans have similar dimensions. To enter typical values, type the value into the appropriate cell in the top row and then press Enter. The typical value will be copied to all the spans.

Click Next on the bottom line to open the input screen, Support Geometry.

### ii. Enter Supports-Geometry (Fig. 1.1-13)

This screen is used to input column /wall heights, widths and depths. You may enter dimensions for columns/walls above and/or below the slab.

Select Lower column from the Support selection box and enter 10 ft (3.05 m) for \(H1\) in the “Typical” row (top row). Press ENTER to assign this value to all the lower columns.

Next, enter the dimensions of the supports. \(B\) is the dimension of the column cross-section normal to the direction of the frame. \(D\) is the column dimension parallel to the frame. For support 1, edit the wall dimensions, \(B\) as 192 inches (4877 mm) and \(D\) as 8
inches (203 mm). For other supports, enter the given column dimensions as shown in Fig. 1.1-13.

Click **Next** on the bottom line to open the next input screen, **Supports Boundary conditions**.

iii. **Enter Supports Boundary Conditions (Fig.1.1-14)**

This screen is used to enter support widths and column boundary conditions. The value you enter for “support width” in this screen is used by the program to reduce the moment to face-of-support.

Support widths can be entered if you answered “Yes” to the “Reduce Moments to face-of-support” question on the **Design Settings** screen, i.e., if you answered “No”, you cannot input values in the **SW** column. This input value will be used to calculate the reduced moments.

Since the support width, **SW**, is set to the column dimension (D) as a default, the SW values will be automatically determined from the support geometry and cannot be modified by the user. If you want to input the SW values, **uncheck** the **SW=Column Dimension** box.

Select **LC (N)** (Lower Column, Near end) and **LC (F)** as 1, fixed, from the drop down list.

Leave the **End Support Fixity** as default **No**. This will be used when the slab or beam is attached to a stiff member. If you want to learn more about this, click **Help** at the bottom of the screen.
1.2 Enter Data

A. Edit the loading information (Fig.1.2-1)

Any number of different loads and load types may be entered for a span.

Enter the span number as 1 in the Span column. If the loads are the same for all the spans, you can type ALL or all in the Span column. This will copy the data to all the spans.

Select the Class as DL from the drop down list and specify the load type as uniform either by typing U in L-? or by dragging the icon from the graphics of the uniform loading. The default of the load type when you select the load Class is L-U; so leave it as is for this tutorial.

Type 0.02 k/ft² (0.96 kN/m²) (without self-weight) for dead load in the w column. You can enter DL with or without self-weight, since the program can calculate self-weight automatically. In order to be calculated automatically, you must answer Yes to the Include Self-Weight question at the top right of the screen and also must enter a unit weight of concrete. Type 150 pcf (2402.85 kg/m³) as the Unit Weight.

Repeat the procedure for live load by entering the span number and changing the Class to LL and the w value to 0.04 k/ft² (1.92 kN/m²) for all the spans.

Answer Yes to Skip Live Load? at the top left of the screen and enter the Skip Factor as 1.
Click **Next** at the bottom of the screen to open the next input screen, *Material-Concrete*. If you entered span as “all”, click **Back** and go back to the loading screen. You can see that all the loadings are copied to the individual spans as in **Fig (1.2-1)**.

**B. Edit the material properties**

**i. Enter The Properties Of Concrete (Fig.1.2-2)**

Select the **Normal weight** and enter the *strength at 28 days* for slab/beam and column. When you press **enter** from the strength input value, the *Modulus of Elasticity* will be calculated automatically based on the concrete strength and the appropriate code formula. For this tutorial, keep the **default values** of strength and creep coefficient. Creep coefficient will be used in the calculation of long-term deflection.
Click **Next** at the bottom of the screen to open the *Material Reinforcement* input screen.

ii. **Enter The Properties Of Reinforcement (Fig.1.2-3)**

Edit the properties of reinforcement and bar sizes. Keep the **default values** as is. The preferred bar sizes for top and bottom will be used when calculating the number of bars required.
iii. Enter The post-tensioning system parameters (Fig.1.2-4)

Select the Post-tensioning system as Unbonded and leave the default values of the other properties as is.

![FIGURE 1.2-4]

Click Next at the bottom of the screen to open the next input screen, Criteria Allowable Stresses.

C. Edit the design criteria

i. Enter The Initial And Final Allowable Stresses. (Fig.1.2-5)

Tensile stresses are input as a multiple of the square root of $f'_c$, and compressive stresses are input as multiple of $f'_c$.

The default values given in this screen are according to the appropriate code, i.e., according to ACI 02 for this case. So leave it as is.

![FIGURE 1.2-5]

Click Next at the bottom of the screen to open the next input screen, Criteria – Recommended Post-Tensioning Values.
ii. Enter The Recommended Post-Tensioning Values (Fig.1.2-6)

This screen is used to specify minimum and maximum values for average precompression (P/A: total prestressing divided by gross cross-sectional area) and percentage of dead load to balance (Wbal). These values are used by the program to determine the post-tensioning requirements and the status of the Pmin/Pmax and WBAL Min/Max indicators on the “Recycle” window.

The values given as default are according to the code and the experience of economical design. So, keep the default values.

![FIGURE 1.2-6](image)

Click Next at the bottom of the screen to open the next input screen, Criteria – Calculation Options.

iii. Select The Post-Tensioning Design Option (Fig.1.2-7)

The two design options are “Force Selection” and “Force/Tendon Selection”, as in Fig.1.2-7. Force Selection is the default option. Keep the default option.

![FIGURE 1.2-7](image)

In this option, a tendon will be assigned a final and constant effective force, equal to the jacking force minus all stress losses, expressed as a single value.

Click Next at the bottom of the screen to open the next input screen, Criteria – Tendon Profile.
iv. Specify The Tendon Profiles (Fig.1.2-8)

Select 1 (Reversed parabola) from the Type drop down list and change the inflection points \((X1/L \& X3/L)\) to zero, since we assumed a parabola with no inflection points. Keep the low point \((X2/L)\) at midspan, i.e., at 0.5.

![FIGURE 1.2-8](image)

Click Next at the bottom of the screen to open the next input screen, Criteria – Minimum Covers.

v. Specify Minimum Covers For Post-Tensioning Tendons And Mild Steel Reinforcement (Fig.1.2-9)

The cover for the prestressing steel is specified to the center of gravity of the strand (cgs). Therefore, for ½ inch (13 mm) strand, cgs is minimum cover + ½ * ½, i.e., \(cgs = \text{cover} + 0.25\) (cgs = cover + ½ *13). Keep the default values for both Post-tensioning and Non-prestressed Reinforcement.

![FIGURE 1.2-9](image)
Click **Next** at the bottom of the screen to open the next input screen, *Criteria – Minimum Bar Extension*.

vi. **Specify Minimum Bar Length and Bar Extension Of Mild Steel Reinforcement (Fig.1.2-10)**

The values given are for development of bars required to supplement prestressing in strength check. Modify if necessary. For this tutorial, keep the **default values**.

Click **Help** to learn about the minimum steel.

![FIGURE 1.2-10](image)

Click **Next** at the bottom of the screen to open the next input screen, *Load Combinations*.

vii. **Input Load Combinations (Fig.1.2-11)**

This screen is used to input the load combination factors for service and strength (ultimate) load conditions. It is also used to enter any applicable strength reduction factors. The default values are according to the ACI-02/05. So, leave it as is.
Click **Next** at the bottom of the screen to open the next input screen, *Criteria-Design Code*.

viii. **Choose The Design Code (Fig.1.2-12)**

   This screen can be used if you want to change the default code. For this tutorial keep ACI-02 code selection.

   This is the last input screen, so click **OK** to close. Then you will see the main program window without any opened screen.

1.3 **Save And Execute The Input Data**

   To save the input data and execute the analysis, either select **Execute Analysis** from the *Action* menu on the menu bar or click on the **Save & Execute Analysis** button. Then, give a **file name** and **directory** in which to save the file. Once the file is saved, the program will automatically execute the analysis by reading the data files and performing a number of preliminary data checks.
Once the execution completes the selection of post-tensioning, the “PT Recycling” window, as shown in Fig 1.3-1 opens. If an error is detected, the program will stop and display a message box indicating the most likely source of the error.

Here you can optimize the design by changing the tendon forces and tendon heights. Change the tendon force and heights as shown in Fig.1.3-2. The status indicator at the top right of the Recycle window will begin to flash.

Since we selected “Force Selection” option during data entry, the program will only allow the “Force Selection” mode for execution.

Once all of the changes are made, click on the Recycle button to update all of the tabs, the “Design Indicator” box and the “Recycle Graphs”. There is no limit on the number of changes that can be made or the number of times the window can be recycled.

After the recalculation of the stresses and required forces along the member based on the current values, the window, as shown in Fig.1.3-3 with “Valid” status indicator, opens.
You can check the final stresses either by clicking **Stresses Tension & Compression [4]** tab in the *PT Recycling* window (Fig.1.3-3) or by clicking **Graphs** at the top left of the screen.

**Graphs** displays a set of three graphs which provide detailed information on the tendon profile, the tension and compression stresses and the required versus provided post-tensioning forces at 1/20<sup>th</sup> points along the spans (Fig.1.3-4).

The top diagram, the **Tendon Height Diagram** shows the elevation of tendon profile selected. Tendon profile can be viewed either with concrete outline or without concrete outline by checking the option at the left of the screen.
The second diagram, **Stress Diagrams**, plots the maximum compressive and tensile stresses at the top and bottom face of the member. You can view the stresses due to Dead Load, Live Load, Post-tensioning and Service Combination each separately, or in combination, by selecting the options at the screen. Also you can verify the top and bottom stresses due to service combination with the allowable values. In **Fig.1.3-4**, it shows the final bottom fiber stress with allowable. In which, gray color represents the allowable stresses, top curve represents the tensile stress and bottom curve represents the compressive stress. If the calculated stress is not within the limit, i.e., the top or bottom curve is outside the gray portion; you need to modify the forces to optimize the design.

The third diagram, **Post-Tensioning Diagrams** shows the required and provided post-tensioning force at 1/20th points along each span. The vertical line represents the required post-tensioning and the horizontal line represents the provided post-tensioning at that section. In the **Fig. 1.3-4** the note that in most parts of the structure the required post-tensioning is zero. That is to say, the stresses due to service combination of dead and live load do not exceed the allowable tension of the code. However, according to the code a minimum precompression of 125 psi (0.86 MPa) is provided (**Fig. 1.3-5**). At each design section along a span, the program performs an analysis based on the post-tensioning force at that section.

If the solutions are not acceptable to you, you can change the post-tensioning layout and recycle until an acceptable solution is reached. Once you are satisfied with the solution, select **Exit** at the top left of the screen to continue with the calculations.

The program continues with the calculations based on the most recent tendon forces and profile selection. Once finished successfully, you return to the main program window with the screen as shown in **Fig.1.3-6**.
Close the above figure by clicking X at the top right corner.

Next, setup the report by selecting **Report Setup** on the **Options** Menu or clicking the **Report Setup** button on the main toolbar. Then the screen as shown in **Fig.1.3-7** opens.

**FIGURE 1.3-7**

Setup the basic output as in **Fig.1.3-7** and the detailed output as in **Fig.1.3-8**. After setup, click **OK**.

**FIGURE 1.3-8**

The report printout will include these selected data blocks.
To open the “PT Summary Report” (Fig. 1.3-9), either click the PTSum button on the tool bar or select PT Summary on the View menu.